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Are you ready to Go! with Got It!™ ? 
 
This Go! Guide will help you use Got It!™ right away! For 
more complete information, please refer to the User Manual 
located on the installation CD. 

 
 

Thank you for choosing the Got It!™ Wireless Student 
Response System. We encourage you to visit our website 
(www.califone.com) to register your product for its warranty 
and  learn more about the complete line of Califone portable 
audio equipment, headphones, computer peripheral and 
language learning materials. 
 
Warranty Registration  
Please visit www.califone.com to register your Got It!™ for 
warranty coverage. It is built to the same standards as the 
rest of our products which teachers rely on day in and day 
out. Califone warrants this Student Response System to be 
free from defective material and workmanship for one year 
from the purchase date. Our “Project Intercept” Customer 
Satisfaction program will replace defective parts and repair 
malfunctioning products under this warranty when the defect 
occurs under normal installation and use, provided the unit is 
returned to our factory via prepaid transportation only after 
the factory issues an RA (Return Authorization) number 
which must be clearly written on the outside of the box. 
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Got It!™ Features and Applications 
 
Got It!™ Interactive Wireless Student Response System is 
the most comprehensive educational technology for the 
classroom environment.  Got It!™ provides a rich user 
interface, with an enhanced activity mode, as well as 
expanded support for multimedia teaching materials. In 
addition, it includes a range of reporting statistics to make it 
even easier to track learning patterns and student progress. 
 
• Use with prepared lesson plans, or ask spontaneous 

questions at any time 
• Evaluate progress for individual students and whole 

classes 
• Performance ratings 
• Classroom surveys 
• Question/Answer sessions 
• Polling 
• Group contests 
 
What Got It!™ Can Do 
Interactive Activity Modes: 
• Standard mode: Got It!™ provides a wide range of 

interactive modes, including Evaluation, Competition 
Quiz, Buzz-in Quiz, Prompt QA, Knock Out Game, as 
well as Presentation, Grading, Survey, Pick Out 
(individuals and groups), Asking Questions, PowerClick 
mode, and Self-Paced modes. 

• On the fly activity mode: Enables the instructor to insert 
questions spontaneously within a lesson, making it easy 
to adapt to current learning situations. 

 
Statistic Reports:  
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• Comparison Report and Semester Report modes make it 
even easier to track individual student and whole-class 
learning history. 

 
Teaching Materials Preparation: 
• High-efficiency EAS files: The new EAS teaching 

materials file format speeds up information access. An 
EAS file is exclusively used in Got It!™ for storing 
question sets – the questions, answers, and the multi-
media attachments. 

• Rich Text format: Supports Microsoft’s® Rich Text File 
(RTF) format, making it easy to import and export 
Microsoft®Word™ and other documents. 

• Multiple display templates: Got It!™ offers a variety of 
display templates covering a wide range of categories 
and graphic styles. 

• Multiple testing formats: With Got It!™, testing materials 
can be presented in a wide range of formats, including 
single choice, multiple choice, true/false, Q&A, 
presentation, buzz-in quiz, competition quiz and more. 

 
Multimedia Support: 
• Multiple format support: Got It!™ supports most common 

media formats, including WAV, MID, MP3, JPEG, BMP, 
GIF, Flash, WMV, HTML, hyperlink, etc. 

• MS® Excel™ equation editor support: Support for 
Microsoft® Excel’s™ equation editor enables instructors 
to integrate graphing, mathematical formulas and more 
into teaching materials. 

 
Multiple Controller Support:  
• Got It!™ supports simultaneous multiple controllers, 

including IR remotes, standard mouse, electronic 
whiteboard, touch display, remote pen pal, and remote 
pointer. 
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System Set Up 
 
Package Contents 
When you receive the Got It!™ package, the following items 
should be included. If you are missing any item(s), contact 
Califone® immediately by phone (818-407-2400 or 800- 702-
0500) or email (warranty@califone.com). 
 

Got It!™ Classroom                    Infrared Receiver 
   System package                     with Bracket and Cable          

 
 
 
 
 
 

   Got It! ™ System   Teacher’s and Students’ 
                   Software CD                       Remote Controls 
 + Electronic Manual 
    
 
 
 
 
 
Software Installation 
NOTE: Do not connect the infrared receiver until you 
have installed the Got It!™ software from the included 
CD-ROM.  
 
Insert the Got It!™ CD into your computer’s CD-ROM drive, 
the menu will start automatically.  If it does not, check your 
local disk drive.  After the autorun menu appears, click the 
Install Got It!™ button.  Follow the InstallShield Wizard 
instructions. When the Complete dialog box appears, click 
Finish. 
 



 

visit us online at califone.com 
7 

  
 
 
 
 
 
 
 
 
 
After the Got It!™ software is installed, the Got It!™ menu 
will appear under Start > Programs > Got It!™, displaying 
the shortcuts to its applications: 
 
• Activity: Launches standard Got It!™ activity modes, 

including Quiz, Competition Quiz, Buzz-In Quiz, Knock 
Out Game, Prompt QA, and Pick Out. 

• Editor: This is the teaching materials editing application, 
used to edit text and insert multimedia files including 
images, animations, videos, sounds, webpages, etc. 

• Manager: Maintain results and statistics needed to track, 
organize and categorize class and student data. 

• Report: Used to generate Got It!™’s range of statistics 
and activity reports. 

• ClickDaemon: This is the setup application for 
communication between the remote control and the  
Got It!™ system software. 

 
Receiver Setup 
• Once you have installed the 

Got It!™ software, connect 
the IR receiver to the 
computer’s USB port: 

 
• Once the receiver is properly 
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connected, position the receiver in a suitable location 
where it is in direct line of sight for all class members, 
and not blocked by desks, walls or other objects. Screw 
receiver into the magnetic bracket provided. The 
magnetic bracket can be used to attach to most 
white/black boards. Also, holes are provided in the 
bracket for attachment to walls. For best results, aim the 
IR remote control directly at the receiver while pressing 
any key. If the receiver does not respond, adjust the 
angle of the receiver.  
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Starting Out 
 
Before using Got It!™ for the first time, the teacher, class 
and student profiles setup must first be completed for each 
individual.  The IT Installer application can be found by 
opening the Editor program found on the desktop and 
clicking on Tools > IT Installer. 
 
Teacher Profile Setup 
In the IT Installer window, select the New Teacher button. 
• In the New Teacher dialog box, insert teacher 

information, and then select OK. 
 
Class Profile Setup 
In the IT Installer window, select the New Class button. 
• In the New Class dialog box, enter the year, grade, class 

name, and number of students into the fields provided. 
Then, click the OK button. 

• To setup a new class, select it from the Class List. Click 
the Name field in the Student List and enter the 
student’s information in the available fields.  

 
Group organization 
• In the IT Installer window, select the Grouping button. In 

the Grouping dialog box, click the New Group button.  
In the New Group dialog box, input the group name, and 
then click OK. 

• The new group name will appear in the left column. Click 
and drag each student’s name from the list on the right to 
the group name on the left. Repeat the process for 
setting up additional groups. Note that each student may 
only be assigned to one group. 
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Creating an Activity 
 
Got It!™ offers a wide range of interactive instructional 
activities, through six main interactive modes.  Each time an 
activity is run, the system will enter the response 
records into the Got It!™ database automatically. 
 
• Ordinary Quiz: Got It!™ presents prepared teaching 

materials in various question formats. Student responses 
and class statistics can be compiled for assessment 
purposes. 

• Competition Quiz: Got It!™ presents test questions in a 
competition style presentation, with students or groups of 
students attempting to be the first to answer each 
question. 

• Buzz-in Quiz: Similar to the competition quiz, however, 
only the first student to buzz in will be called upon to 
answer the question. 

• Knock out Game: Students who answer incorrectly are 
disqualified from answering further questions, ultimately 
resulting in a single “winner.” 

• Prompt QA: This is a pure vote-tallying mode, with the 
instructor dictating the question for immediate response. 

• Pick out: This is used to pick out a student at random to 
answer a question. It is useful for individual or group 
surveying. 
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To generate a new EAS Activity file  
• Double-click the activity icon on the desktop. Click New 

on the File menu, or the New File icon. In the New 
Lesson File dialog box, select or enter Course, Author 
and Title, and then click OK. Select the Activity Mode 
(Ordinary Quiz, Pick Out, etc.) and Question Format 
(Multiple Choice, True/False, etc.) using the drop-down 
list. 

• To add new questions, click the New Item button or 
select New Item from the Edit menu. In the Editor 
window, type in the question, enter a selection of 
response options in the answer fields, and click the check 
box next to the correct answer. Also select the number of 
points given for each question, time provided to complete 
each question and the level of difficulty for each question.  

• On the top Font tool bar, you may select the font and 
other options as well. To preview an individual question 
during editing, click the Preview button on the tool bar. 
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How to Use Got It!™  
 
Using an Activity 
• Double click the Activity Icon on your desktop. In the 

Select Class window, select the desired class. In the 
Select Activity window, select the desired activity 
function.  

• When the Select Material window appears, click on the 
Up or Down arrow to browse available subjects; the Left 
and Right arrows for the types of material provided under 
the chosen subject. 

• When the Ready window appears, students are 
instructed to get their remote controls ready. The teacher 
introduces the activity, then presses  or   
button to begin.  

• When the main activity window appears, the students 
press the number buttons on the remote control to 
answer the question. The activity name, timer and title of 
EAS file are displayed at the top of the window, the 
Answer Status Area is at the bottom, and the tool bar is 
on the right. 
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Self-Paced Mode 
The Self-Paced activity mode may be called the electronic 
version of the traditional paper question and answer 
assignment. The teacher prepares an EAS file with 
questions and multiple choice answers using Got It!™. This 
is then printed out and a copy is given to each student. The 
students work through the assignment at their own speed, 
recording the answers with their remotes as they are ready. 
When the test is completed, the instructor can review the 
students’ answers using the Report program. 
 
To print test or questionnaire: 
• Open an EAS file from the Editor window, then click 

Print on the File menu. 
• When the Print dialog box appears, select the printer you 

want to use, then select to print. 
 
To operate the Self-Paced mode: 
• Launch the Activity program, then select a class from 

the Select Class window. In the Select Activity window, 
select Self-Paced.  In the Select Materials window, 
select the desired EAS file, then press or click the button. 

• When the Ready window appears, the instructor can 
introduce the activity process, then presses  or 

  button to begin the Self-Paced activity. 
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PowerClick Mode 
The PowerClick activity mode enables Got It!™ to be 
integrated with Power Point® files with only minimal effort in 
preparation.  In Got It!™ PowerClick mode, each 
PowerPoint® slide corresponds to a question. When the 
desired slide appears, the students can answer the 
corresponding question with a click of the remote. The slide 
number is on the top left corner. 
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Generating Reports 
 
Got It!™ provides six different types of reports to analyze 
students’ responses and progress. To access the Report 
function, double click the Editor icon on your desktop, then 
Run(R) > History. 
 
Got It!™ provides six different types of reports to analyze 
students’ responses and progress. 
 
• The Summary Report displays the overall answering 

times and detailed response data for each student. 
• The Grade Report is a report card that provides parents 

with information regarding students’ learning results. 
• The Activity Detail Report will display the class’ number 

of correct responses, the rate of correct responses and 
the contents of each question. 

• The Historical Report is useful for tracking learning 
curves of individuals and classes. 

• The Comparison Report displays a comparison of 
students’ grades for a particular subject or lesson. 

• The Semester Report compiles and prints mid- or final-
term results for all activities. 

 
 
To Delete Records: Select the records from the Records 
List, and then click on the Delete Reports button to delete. 
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If you are using Windows Vista™  
 
In Windows Vista™, there is a “User Account Control (UAC)” 
which may block communication with the receiver.  Before 
installing Got It!™, turn off the “User Account Control”.  Login 
as administrator in Windows Vista™. 
 
To turn off the “User Account Control” –  
 
1.  Click Start, and then click Control Panel. 
2.  In Control Panel, click User Accounts. 
3.  In the User Accounts window, click User Accounts. 
4.  In the User Accounts tasks window, click Turn User 

Account Control on or off. 
5.  When the User Account Control message appears. 

Click Continue. 
6.  Uncheck the Use User Account Control (UAC) to help 

protect your computer check box, and then click OK.  
 

 
 
7.  Click Restart Now to apply the change. 
 



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /FRA <>
    /ENU (Use these settings to create PDF documents with higher image resolution for improved printing quality. The PDF documents can be opened with Acrobat and Reader 5.0 and later.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
    /KOR <FEFFd5a5c0c1b41c0020c778c1c40020d488c9c8c7440020c5bbae300020c704d5740020ace0d574c0c1b3c4c7580020c774bbf8c9c0b97c0020c0acc6a9d558c5ec00200050004400460020bb38c11cb97c0020b9ccb4e4b824ba740020c7740020c124c815c7440020c0acc6a9d558c2edc2dcc624002e0020c7740020c124c815c7440020c0acc6a9d558c5ec0020b9ccb4e000200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /CHS <FEFF4f7f75288fd94e9b8bbe7f6e521b5efa76840020005000440046002065876863ff0c5c065305542b66f49ad8768456fe50cf52068fa87387ff0c4ee563d09ad8625353708d2891cf30028be5002000500044004600206587686353ef4ee54f7f752800200020004100630072006f00620061007400204e0e002000520065006100640065007200200035002e00300020548c66f49ad87248672c62535f003002>
    /CHT <FEFF4f7f752890194e9b8a2d5b9a5efa7acb76840020005000440046002065874ef65305542b8f039ad876845f7150cf89e367905ea6ff0c4fbf65bc63d066075217537054c18cea3002005000440046002065874ef653ef4ee54f7f75280020004100630072006f0062006100740020548c002000520065006100640065007200200035002e0030002053ca66f465b07248672c4f86958b555f3002>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


